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Why Produce Guidelines To Internet Safety?

Not long ago it took a large building to house a computer with a fraction of the computing capacity of
the average American home today. Our technological advancement has been staggering. The Internet holds vast
quantities of helpful information; from the latest school project to updates on civic activities to help with the lat-
est plumbing project, the web holds great potential. However, as with any tool, it can also be used in negative
ways. The opportunity for involvement in pornography and violence through the Internet defies belief.
Electronic communications can also be used to destroy our most significant relationships.

This guide is published as a resource for parents, educators, library personnel and community leaders
who are concerned about the safety of children. The need for this information is evidenced by both the explo-
sive growth in computer use and the targeting of children by predators. Recent research indicates that one in
five children using the Internet regularly is approached for sex. Teenagers spend an average of 8.5 hours per
week chatting and sending e-mail on the Internet compared with only 1.8 hours of computer use for school
work. It's easier for cyber-porn to make its way into your home than it is to borrow a book from your neighbor.
The anonymity of the Internet has also allowed pedophiles and stalkers to use electronic mail and “chat rooms”
to lure their victims into dangerous liaisons.

There is almost no legislation regulating the Internet. However, more and more providers are provid-
ing parental control or screening options. There are also a growing number of software programs that can suc-
cessfully block or filter out most unwanted sites. And, there are many steps we can take as adults to properly
manage this medium.

But even technological help has its limits. Ultimately there is no replacement for parental involvement,
communication and reliable community practices to protect our children.

It is our sincere hope that this guide will give you the tools you need to protect your family and suc-
cessfully manage this resource.
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Introduction

A new era in communication

The Internet is revolutionizing the way we
communicate information across the world and
across town. Increasingly, the answer to almost
any question starts with, “Let’s do an Internet
search.” Although there is a tremendous
amount of “junk” out there, there are many
easy-to-find nuggets of good information or
services that would otherwise be unavailable or
at least very hard to obtain.

Families are recognizing the benefits and
potential for the Internet, and are getting con-
nected at an unprecedented rate. Most home
computers purchased today are for the
expressed purpose of “getting on the Internet.”
Given the fact that the World Wide Web did
not exist until 1994, we are witnessing the birth
of a new era in communication.

Why family guidelines are so
important

Immediate and private access to “informa-
tion” is a double-edged sword. On the one

hand, unnecessary barriers have been
removed. That is a good thing. On the other
hand, traditional barriers of protection for chil-
dren have crumbled as well, potentially expos-
ing them to dangers that were unheard of ten
years ago. For example, in former times chil-
dren were protected from pornography by the
location and doors of adult bookstores, along
with laws that prevented children from enter-
ing such establishments.

Another danger is the abduction or abuse
of children by “friends” they meet on the
Internet, either by email or in chat rooms.
Parents teach their children to be wary of
strangers, but Internet friends appear to be like
the harmless pen pals we grew up with. Of
course, many of those friends are just that —
same age/interest children who want to con-
verse with our kids. However, some of them
are adult predators masquerading as children.
The anonymity of the Internet makes it very dif-
ficult or impossible to tell the difference.

As parents, we can no longer depend on
the traditional barriers to protect our children.
Family Internet guidelines are the first and last
line of defense to prevent possible disasters.

The answers are not obvious

As a parent, there are several options you
have to deal with these dangers. Unfortunately,
there is no easy answer to what measures will
work best in your family; there are too many
variables:

Age and gender of the child

Levels of parent and child computer
knowledge

Spectrum of compliant to rebellious per-
sonality in the child, along with level of
curiosity

How well parent-declared rules and conse-
quences are followed through (in general)
The child’s and parent’s understanding
that pornography is a bad idea and should
be avoided

Ownership and location of the computer
Amount of “home alone” time the child
has

Parental time and energy available to mon-
itor Internet usage

Nature of relationships between siblings
All of these elements, as applied to the
homes of the child’s friends

In the end, you will have to make the most
informed decisions you can based on your fami-
ly’s unique situation. This guide is intended to
help with those decisions and policies.

Who should read this?

All parents should be interested in this
subject, whether or not their children have
Internet access at home.
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Understanding how to use the information flow

USING THE INTERNET

Finding the good stuff

The bulk of this booklet will deal with
dangers of the Internet, but don’t let that scare
you away. The Internet provides quick and easy
access to a wealth of good information. There
are many starting points that will point your
family in the right direction. Here are just a few.

Everyone in the family can benefit from
Yahoo, which is a set of human-chosen web
sites on virtually any topic. Unfortunately, some
of those topics visit the Dark Side, so it is
important to have an Internet filter or monitor
in place (see below) when using Yahoo or any
other search facility. (www.yahoo.com)

Yahoo has created Yahooligans which is
specifically designed for kids. It allows searches
on any topic, but filters out adult material:
(www.yahooligans.com)

There are several general web search facili-
ties available; all of them can potentially drop
the user into the middle of adult sites. (In fact,
pornographers take advantage of that by cod-
ing their pages to come up for innocent search-
es.) Even if an Internet filter prevents your
child from actually going to an inappropriate
web site, you may not want your children to
see the language in the site’s short summary
which gets shown with search results. For this
reason, some search engines let you configure
searches to perform lightweight filtering. For
example: www.lycos.com (“SearchGuard”)
www.google.com (“Safesearch”)

Danger on the Dark Side

The Internet’s Dark Side is very ugly.
Unfortunately, most people seem to think
Internet pornography is just a collection of
Playboy-like naked women or “pin-up girls.” This
is not true. In addition to sex between two
adults, every imaginable variant is displayed. This
could involve violence, animals, waste products,
and group arrangements.




Many parents believe that the “bad” hard-
core pornography requires a credit card to
obtain, and thus children are not likely to get
there. Not true. While all porn sites do invite
you to use a credit card to get deeper into that
site, many of them have numerous free high-
detail “sample” images.

Parents often have a rose-colored view of
what their kids may or may not do. In one
sense, that’s good — kids need to know that
there is someone who will err in the direction
of trust rather than mistrust. But don't let that
trust lull you into complacency. A teenager’s
hormone-fueled curiosity is an extremely pow-
erful force; you should not underestimate its
power to draw your “good kid.” Many good par-
ents never imagined that this could be a prob-
lem in their home — yet it was.

Is Playboy really on the
Dark Side?

What about softcore porn? There are those
who say that since God created the female body
as a thing of beauty, there is no problem letting
children see images from www.playboy.com
and other similar softcore sites. In reality, any
pornographic portrayal of women is degrading
and dangerous. Pornography is invasive and
progressive. By invasive, I mean that for a boy
brimming with hormones, pornographic images
take hold of his imagination and won't let go.
Pornography is progressive in that excitement
turns to boredom after a while, and the viewer
is drawn into harder and harder core material.
Eventually, a boy gets bored with seeing “nor-
mal” things that a man and woman can do
together, and excitement comes from seeing
deviant sexualviolent behavior. It's all “out
there,” waiting for curious souls to click on
readily available hyperlinks.

For more information on the destructive
nature of pornography, see the Resource List
section at the end of this guide.

The enemy works a 24-7 shift

The Internet’s Dark Side is not a passive
danger. Pornographers have many tools in their
arsenal to draw young teenagers into their
world, intending to hook them for life. For
example, porn proprietors hijack common mis-
spellings of popular sites. They send out thou-
sands of speculative “spam” email messages

containing inviting web hyperlinks. If your child
clicks on one of those email message links,
many browser windows are often spawned
simultaneously, each one open to a different
porn site. These windows often employ a con-
cept called mouse trapping, meaning that if you
try to close a window, it automatically re-opens
to a different porn site. Also, if you respond to
certain email messages with an “unsubscribe”
directive, your email address can be sold on a
premium “active” list, which may spark much
more of the pornographic email spam. Porn

sites also sell advertising space to other porn
sites, so one page can lead to another and
another.

What makes home Internet access so dan-
gerous (as compared to the public library, for
example) is the combination of privacy and
opportunity. All families leave older children
home alone at times, and many kids will find
the temptation to explore the Internet’s Dark
Side irresistible.




DEALING WITH
THE DANGERS

Prevention

Short of locking your kids in a closet
throughout their childhoods, there is nothing
you can do to completely protect them from
pornography unless they cooperate with you.
Pornography is so accessible today that given
enough motivation kids can get it somewhere —
at their friends” houses, at the public library,
even from dumpsters. So, you need to help
them be internally motivated to avoid pornogra-
phy—not just because you say so (although that
helps), but because they recognize how degrad-
ing and dangerous it can be.

Educate them about the negative nature of
pornography. Help them conclude that, even
given an opportunity, they want to avoid it.
Then, the barriers you place between your kids
and pornography will be seen as friendly
reminders — like the fence alongside a cliff —
helping them avoid giving in to temptation.
Educated agreement is the best protection,
because it is active wherever your child goes.

It may seem obvious, but also make sure
your kids understand that accessing Internet
pornography on the home computer will not be
tolerated. Violation of that family policy should
at the very least result in loss of Internet privi-
leges for a time. If this consequence is posed in
the right spirit, the child should consider it
another friendly protection from what he or she
already knows is wrong.

Of course, the parent’s ultimate weapon
against Internet abuse is totally pulling the plug
on the Internet connection. As you will read
next though, that action is not as simple as you
might think.

Protection “without” an
Internet connection

Many parents think that if they cancel their
Internet Service Provider (ISP)—or never sub-
scribe to one, they don't need to worry about
Internet pornography in their home. This is not
the case. Several ISPs offer extended "free no-
credit-card” trial periods—plenty of time for your
child to get deeply into the Dark Side of the
Internet.

There is nothing to prevent your child from

signing up for one of these services. One nation-
wide ISP sign-up screen asks a self-dentified
child to call a parent over to press a “Consent”
button; another says, “Click here if you are at
least 18 years old.” Granted, there is some per-
centage of super-honest children who will not
press these buttons themselves. But the rest of
the kids will just click and continue. Once the
ISP is set up, it is very easy to hide the “start”
icon somewhere that a parent would never look.
The bottom line is that even if you don’t think
you have the Internet in your home, it could still
be there.

Depending on the relationship you have
with your kids, you may be able to deal with this
possibility by merely watching for signs of
Internet activity (see "Detection” below). If; in
an extreme case you need to "pull the plug,"
you could remove or disable the modem. Of
course, a child who works that hard to circum-
vent your protections will likely find another way
to obtain pornography - but at least you'll be
able to have important conversations if you
know about the attempts.

“Clean” Internet connections

The positive aspects of the Internet are
strong enough that most families will want to
provide some access to the Internet. One way to
do this relatively safely is to use a “clean” ISP.
This is an Internet provider that pre-filters the
Internet before it reaches your home. There are
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advantages and disadvantages of this protection
method. On the plus side, you don’t have to
install filtering software and keep it updated. A
negative is that you as the parent don’t have
control over what gets filtered and what does
not — the ISP’s notion of what is inappropriate
may or may not match yours. With a filter, you
can configure it to your family standards. (For
example, what about skimpy swimsuits and lin-
gerie? Will the ISP agree with your answer to that
question? If not, there is little you can do about
it.) However, for many families, a clean ISP can
be the ideal solution. (See our resource list on
page 15)

If your ISP is America Online (AOL), you
can set filtering levels for each family member.
(Keyword "Parental Controls")

Note however that a clever child can cir-
cumvent a clean ISP by simply signing up for
their own trial-ISP account as described eatlier,
which can silently co-exist with your official fami-
ly dial-up, cable, or DSL-based service provider.

Also, keep in mind that no filter is perfect
— even one used by a clean ISP. Not all “bad”
sites are blocked, so you should still perform
Supervision and Detection as indicated below.

Protection for an unrestricted
Internet connection

If your ISP doesn't pre-filter the Internet,
and children have access to the machine, you
absolutely must install filtering or monitoring




software — no exceptions.

It is not fair to put any kid in a “don’t look
inside the box” situation, but that’s exactly what
an unprotected Internet connection represents.

Which filter should you use? A complete
review is beyond the scope of this guide. Much
has been written about various filtering prod-
ucts. In general, you should choose one which
blocks by using a subscribed-to list of known
bad sites rather than by attempting to identify
pornographic sites by words in the site address-
es or on the web pages. You as the parent
should also be able to configure the filter to
block or unblock specific sites or web searches.
One of the most popular filters in this category is
CyberPatrol at www.cyberpatrol.com (or call 1-
800-828-2608).

Even after you install an Internet filter,
don’t become complacent. Many new porn sites
are added daily. You should update your filter
regularly — something that good filter software
will remind you to do.

Note that filtering software will work even
in the case of an alternate ISP described above.

Again, realize that no filter is perfect; you
should still perform Supervision and Detection
as indicated below. Without a filter, a child can
find thousands of pornographic sites in seconds.
With a filter, it can take an hour to find some of
the few images that make it through the filter—
but it can still be done.

Monitoring Software

Some products assist you by silently keep-
ing a historical record of Internet activity that
your child cannot clear. Monitoring software will
work even in the case of an alternate ISP
described above.

This is not a filter (although some monitors
do provide limited filtering). Instead, a monitor
lets you see where the computer has been. Of
course, this method is only effective if you regu-
larly review the history, and you hold your child
accountable for where he goes on the Internet.
However in some families, the un-clearable trail
could be a better deterrent than any filter. A top-
rated product in this category is Cyber Snoop,
which can be downloaded from Pearl Software
(1-800-732-7596): www.cyber-snoop.com

Note that if you install both filtering and
monitoring software, they may conflict with each
other since they both want to "own" the

Internet communication channel. However,
monitoring products can co-exist peacefully with
a clean ISP (see "Clean" Internet Connections
above). The combination of a clean ISP and
monitoring software on the computer is perhaps
the most useful protection technique.

SUPERVISION

Some experts say that Internet access
should be supervised by a parent (“always surf
the web together with your child”) —a good
idea that is made impractical by the fast pace in
most of today’s families. However, there is
something to be said for the concept of supervi-
sion. A child is far less likely to bring up ques-
tionable material if there is a chance of easy dis-
covery. For this reason, I strongly urge caution
regarding Internet connections in a child’s bed-
room. It is much better for the computer to be
in a prominent family-frequented location,
preferably with the screen visible from the door-
way and an outside window. Even if a bedroom
computer s filtered and/or monitored, you
should carefully weigh the risks of privacy
against perceived benefits. You must assess
whether or not your child is mature enough to
handle a private connection.

Detection: Basics

Hopefully, you have established a relation-
ship of mutual trust with your children.
However, your job as a good parent requires
you to ensure that your trust is justified. You
need to know what your family computer is
being used for.

An unfortunate situation has arisen in many
of today’s families: the children know more
about the computer than their parents do. While
it is good for a child to be computer literate in
today’s technology-saturated society, it also
means that such a child can hide almost any-
thing from a computer-illiterate parent.

The information in this Guide will help bal-
ance the scales somewhat — but there is really
no substitute for parent computer education.
You should use one of the many sources of
Internet-oriented computer education: commu-
nity colleges, public libraries, even computer
stores. There are also self-study books written
for the technically challenged (a.ka. “dum-
mies”). Your job as a good parent depends on
your ability to monitor what is going on with

your home computer, and you can’t do that
effectively in a knowledge vacuum.

In this Guide’s discussion of Detection, I
will concentrate on the most common operating
systems (Windows 95/98/ME/XP) and the most
common web browsers (Internet Explorer and
Netscape Navigator; note that America Online’s
browser is based on one of those two browsers,
depending on the AOL version). The same prin-
ciples apply to other operating systems and
browsers, although the details may be different.
Note also that there are non-browser ways of
getting image files: FTP, Unencoded email, etc. I
won't discuss those methods here, but one way
or another the results would be saved graphic
image files, which are discussed below.

What should you do if you find something
suspicious but not conclusive? I don’t recom-
mend an immediate confrontation, especially if
you are not very computer literate. There could
be a legitimate reason for what you found.
However, it should be a yellow flag for you to
watch the situation more closely, and perhaps
when appropriate ask strategic questions of your
child.

Detection: Behavior Changes

You know your child the best, and should
be concerned if there is a noticeable change in
behavior. Alfred O. Olsen, Chief of the Warwick
Township (Lititz, Pennsylvania) Police
Department, is a nationally recognized expert on
Internet crime. Chief Olsen has collected some
warning signs you should watch for, including:

Loss of interest in social activities (with-
drawal from friends, family)

Uses of new (unusual) vocabulary, heavy
with computer terms, satanic phrases, or
sexual references — or sudden interest in
related posters, music, etc. Look for related
doodling or writing.

Use of words such as: hacking, phreaking
(or any words with “ph” replacing “f")
Lack of interest in self and appearance or
indications of lack of sleep




DETECTION:
TEMPORARY
INTERNET FILES
(CACHE)

This section describes one of the
most useful detection methods. When
aweb browser loads a page from the
Internet, it keeps a temporary “local”
copy (on your computer’s hard disk)
of everything on that page. This makes
loading the same web pages faster the
next time, since less data needs to be
downloaded from the Internet.

M

Most versions of AOL's browser are
based on Internet Explorer, so you can
just open IE directly and follow the
instructions under Internet Explorer
on this page.

America Online
(AOL):

=3 | Internet Explorer:

= I8 5= B 1s= Startby putting the browser in
-l - “Offline” mode, by choosing File
> Work Offline from the menu.
This lets the browser work with-
out getting on the Internet.
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On the menu, choose Tools > Internet Options. (With
Internet Explorer 4, it is View > Internet Options.)
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On the Internet Options dialog, click on the Settings but-

ton. This will bring up the Settings dialog box.
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From there, click on the View Files button, which will
bring up a Temporary Internet Files window.

Each column heading is a button that, if clicked on, will sort
the list according to the contents of that column. Clicking that
button a second time will reverse the direction of the sort. If
you position the mouse cursor between the buttons, you can
resize the columns to see better the information you are inter-
ested in. In this case, you want to see the Name, Internet
Address, Size, and Last Access columns.

Web graphics come in different file formats; the one most

commonly used for pornography is “JPEG” (often abbreviated
“JPG"). The icons to the left of the file name may be different

than the picture above, depending on your system configura-
tion. Also, you may not see the extension (e.g. JPG).

To see a picture, double-click on the icon next to the
filename. You may get a dialog box that says, “Running a sys-
tem command on this item may be unsafe. Do you wish to
continue?”

[T Click on the Yes

e e . ™| button, and the pic-
ture will be dis-
—= || played. Most
Internet photograph
files are between 30 KB and 100 KB in size; sorting by size lets
you zero in on the files most likely to be inappropriate.

The ability to sort on the different columns lets you
explore other aspects of the Internet browsing sessions. For
example, sorting by Last Access date lets you examine what
was looked at during a time you know your child was home
alone. If you find suspicious material, sorting by Internet
Address lets you see what else was seen from that site.

Note that if a picture appears in the Temporary Internet
Files, it was seen by the user. (This is unlike the History
record described below, which indicates attempted access
regardless of whether or not it was blocked by a filter.)

Unfortunately, Netscape Navigator is not as

helpful in showing you the temporary Internet files. However,
unlike Internet Explorer which hides the temporary files,
Netscape’s temporary “cache” will show up as regular image
files — detectable by the procedure below under “Saved
graphic image files.”

Netscape Navigator:




DETECTION: SAVED GRAPHIC
IMAGE FILES

If your child has been viewing Internet pornography, there will very likely
be downloaded images files somewhere. Depending on how much effort is
being spent on hiding them, you may or may not be able to find them. In
extreme cases, the child could even use free Internet file storage space that
some vendors offer. However, you should look locally on the computer’s hard
disk; that’s their most likely location, because they can be viewed without going
online.

Checking out a sample of these files is not a guarantee that your child has-
n't hidden something from you. However, these steps represent a good-faith
effort to make sure that your trust in the child isn’t misplaced.

Windows 95/98/ME:

The Windows operating system provides
an easy way to look for files of certain
types. From the Windows Start menu,
choose “Find > Files or Folders.”
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| side of the dots (*."); the

space after the comma is

optional. (*,jpg, *jpeg, *.mht, *mhtml) For “Look in,” click on the down-arrow
and choose “Local hard drives.” (If that choice is not available on your operating
system version, you will need to choose a specific hard drive like “C:” and repeat
the operation if needed for other hard disk drive letters.) Also, make sure that
the “Include subfolders” box is checked. Lastly, click on the “Find Now” button.

While the computer is
; s I'_'II_“:_“ e looking, the magnifying glass
— . |E=E=1 1 under the “New Search” but-
Lot - [T ] .;_| E ton will move in a circle. When
£ etan-mny 5 it stops, you can look at the
[ files that were found. There
' = S [5a=] will likely be many files — per-
; -E haps even thousands. You can
] click on the “Size” column
¢l . o7l heading to sort the list accord-
I ing to how much disk space

the files use. Click “Size” again,
and the list will be sorted to show the biggest files at the top. Most Internet pho-
tograph files are between 30 KB and 100 KB in size; double-click on their icons
at the left to see them. Note that “mht” files are fully captured web pages with all
of the pictures embedded inside, so they will be bigger than single pictures.
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Windows XP:

Windows XP makes it easy to search
for image files. From the Start button,
choose Search. That brings up the fol-
lowing window:

Click on the "All files
and folders" button,
which results in this
window:
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the filename,” type
"] in the following. Do
not put blanks on
either side of the
dots (“”); the
space after the
comma is optional:
*jpg, *jpeg, *.mh,
— | *mhtml. Click the

— | Search button. The
- computer will look

throughout your computer’s disk drive and display the results as a list of files, as dis-
cussed for Windows 95/98/ME. If desired, you can click on the “view results differ-
ently” button, then click on “thumbnails” to see a pictoral representation of each file,

as shown here.
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Internet Explorer:
On the menu, choose Favorites and any

DETECTION:

Netscape Navigator:
On the menu, choose Communicator >

BOOKMARKS/

interesting submenus

Bookmarks and any interesting submenus.

FAVORITES

When an Internet surfer
finds something useful, he or she
will often bookmark that site, so it
can be easily returned to later.
Although it is possible to mis-
name or hide bookmarks in
obscure places, you should look at
the ordinary saved bookmarks to
see what is there.
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DETECTION: INTERNET BROWSING
HISTORY

While an Internet browser is being used, it keeps a record of every place it has been on
the web, for a user-specified number of days. You can access this record and see where your

Internet Explorer:
On the menu, choose View > Explorer Bar >

child has been or tried to go. Sometimes the web address will be obvious, e.g.

www.hustler.com. If you are unsure, and you are online with your ISP, you can click (or dou-
ble-click, in the case of Netscape) on the link from the history window, and go there yourself.
If the history is blank or sparse, consider what that might mean. The user can clear the histo-

History.

ry at will, but why would your child want to do that? Hestory X
Note that the history indicates attempted access, regardless of whether or not it was o Today ,‘i =3 |
blocked by a filter. 2 ach2 zdnet com
L]

Netscape Navigator:
On the menu, choose Communicator > Tools > History.
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Away From home

Unbelievably, many public libraries allow children to view Internet pornography, in the name of “freedom
of speech.” You should find out what your local Library’s Internet policy is, and what you might inadvertently
authorize your child to access. Hint: if the policy doesn’t specifically prohibit the display of pornography or
obscenity, and the machines are unfiltered, then your child is at risk. (Even if the child doesn’t access pornogra-
phy, other patrons may do so in your child’s view.)

Another danger zone is at a friend’s house, where Internet guidelines may not be in place. If your child is
so inclined, he could bring home a floppy disk or CD filled with pornographic images for later viewing or print-
ing. If those files are copied to the computer’s hard disk, then the Detection procedures above may find them.

Last but not least, there is regular old fashioned printed pornography. The modern wrinkle on this theme
is that kids can print their own copies of images using the photo-quality printers that many families own.

Conclusion

The most effective protection for your children
starts with educating them about the destructiveness
of pornography. Then, you need to help your kids
stay honest by putting up a “fence along the cliff,” i.e.
an Internet filter or monitor, and possibly using a
clean ISP. To keep the kids from climbing over the
“fence,” you need to diligently monitor their Internet
usage and follow through if they abuse their Internet
privileges.

Don't be afraid of the Internet, but take charge
of its presence in your home. Your family will surely
benefit from your efforts.




Output

Understanding the dangers of on-line relationships

On-line Relationships

Online relationships are not much differ-
ent from traditional ones. The same happiness
and hurt that happens as a part of school, work,
or neighborhood relationships, happens in chat-
rooms and electronic mail. Unfortunately, the
deception that some individuals work through
traditional relationships is even more effective
on-line. Relationships created over a computer
are easier to control, and those who exercise
control with the purpose to harm, have found
the Internet a virtual playground. However, for
individuals who see relationships as opportuni-
ties to grow, laugh, share burdens, and commu-
nicate compassion, the Internet is an amazing
technology that unites continents and cultures.
Goethe’s maxim, "a thing shared between
friends holds twice the beauty," seems even
more true at the keyboard, where each typed
phrase can add a sense of community.

The On-line Family

We all know what it is like to miss some-
one. A spouse traveling for business, a child
away at school, a sibling in another state. The
Internet provides such a forum through shared
letters, real-time chat, pictures and video. Today
many families wake-up every morning to elec-
tronic messages full of humorous anecdotes, pic-
tures of new family members, requests for
prayer, and details about health, engagements,
weddings, honors and awards.

Re-establishing Relationships:

Old friends. College roommates. Former
teammates. Lost family members. Favorite teach-
ers and ministers. Finding them is just a matter
of searching for addresses or phone numbers at
various on-line sites. A few laughs, a few tears
later, and the years and miles melt away.

Time and Friendship:
The Internet provides the time to say what
you really mean. It allows friends to chat, watch-




ing what the other is writing as they write it. It
allows those who need more time to send email
letters without worrying about having to rush
their thoughts. The Internet provides opportuni-
ties for reflection before responding, for thinking
through rather than walking out. It allows
friends to respond immediately or to take time
to say something carefully, compassionately.

Networking

Every employee knows the value of meet-
ing professionals in other organizations. The
Internet provides opportunities for sharing ideas
about problem-solving, handling interpersonal
conflicts, market trends, and other issues. The
electronic transfer of information also increases
the rate at which projects and other work assign-
ments can be completed. Correspondence with
employees in other states or countries is more
effective on-line, and the expediency of the
Internet increases an organization’s productivity.

The Screen, the Mask, and the
Danger of Anonymity

Because Internet communication isn't face
to face, individuals can use the computer
screen as a kind of mask. The lack of accounta-
bility and the relative anonymity create two dis-
tinct dangers.

First, the lack of accountability causes some
individuals to stretch the truth, to make claims
and statements that damage trust. Without trust,
interpersonal relationships and entire organiza-
tions struggle under the burden of suspicion.
The inability to communicate face to face can
create a "they can’t see me mentality” that
emboldens vice and supplants virtue. Every day,
men and women are led to believe lies, deceived
by both their desire for new intimacies and the
"unseen"” individuals whose amorous advances
are merely masquerades.

Second, because of the anonymity associat-
ed with the screen, spouses, employees, family,
and friends can fall into the trap of believing that
personal interaction isn’t as necessary. The dan-
ger lies in the lack of risk — the missing vulnera-
bility that engenders genuine ties, fosters famil-
jarity, and hones the kind of honesty that makes
relationships vigorous and vital. What the Beatles
sang so long ago is true, "all the lonely people”
are those, who wear "masks" that they "keep in
the jar by the door." Although today’s door is a

keyboard, and today’s mask is a computer
screen, the resulting loneliness created by false-
hood and fabrication, is still the same.

Personal Information as a Snare
We've all read frightening newspaper
accounts of a child being abducted by an online

"friend" -- someone who turned out to be an
adult child molester masquerading as a same-age
pen pal. It is imperative to teach your children
to never share personal information like their
full name, address, phone number, school
name, etc. with someone they've never met. If
the online friend wants to meet your child, you
must arrange and supervise that meeting.

Stepping away from
Harmful On-line Activity

If you are concerned that a friend or family
member is being deceived by someone on the
Internet or is viewing harmful material, approach
them calmly, maybe over a cup of coffee or a
soda, and mention your concern. Admit that you
may be "jumping to conclusions," but ask them
to be honest with you about the relationship.

Ask them if they can tell you what the dan-
gers are for other individuals, and if any of those
same dangers may pose potential problems for
them. If they own up to the dangers and want

your help, you can offer to participate in
accountability measures - installation of moni-
toring software or periodic review of their hard
drive files, for example. In any case, you must
maintain a good relationship or you could inad-
vertently drive them deeper into the online
"friendship." Be careful with the suggestions
you make and how you present them.

If the person is your spouse or child, you
need to be more proactive. Where someone
like that has demonstrated a problem with
unhealthy online behaviors, the spouse or par-
ent should insist on easy access to the computer
and its contents. This will help provide account-
ability for any recovery efforts or newly-drawn
boundaries. See the section on Supervision and
the Resource List in the back of this booklet for
further help.

Before you dismiss an on-line relationship
as "harmless," remember that the lack of
accountability, the ease of deception, and the
anonymity the keyboard provides, make on-line
relationships potential sources of instability.

The benefits and blessings of on-line rela-
tionships far outweigh the dangers for most indi-
viduals. The key is to outline the dangers for
your family, to talk about them openly, and to
create a kind of accountability that will foster
healthy friendships.




Processing

Ideas on how helpful the Internet can be

The Internet can be an incredible tool, if
used with care. Although teachers and other
professionals are quick to warn about the
absence of accountability for on-line sources
(made-up facts, inaccurate dates, etc.), the
Internet does provide almost immediate access
to information. Like a huge, international ency-
clopedia index, Internet search capabilities allow
you to focus your time and effort on specific
words, phrases, events, and dates. Type in a few
key words, and within minutes, the delights of
discovery are yours.

Information updates

The Internet is a great source for immedi-
ate updates. Community, school, city, and state
calendars, public agency meeting dates and

notes, legislative issues, even fish stocking sched-

ules can keep you up to speed with what's hap-
pening and when. You can keep current on air-
line ticket prices, vacation packages, changes in
the stock markets, book deals, job openings,
and, of course, the issues that surround organi-
zations like the Georgia Family Council.

Data Source

In the past, most consumers did not have
the time to access collections of local, state or
federal statistics. It was even difficult to locate
sources. Internet searches, however, allow any-
one to access survey results about business and
societal trends, what government and private
research projects are underway, and what these
agencies are finding out. The Internet contains
on-line libraries and a variety of free, as well as,
subscription-oriented databases, making your
research an easier search.

Education

Parents who help their children with school

projects have found the Internet a valuable
source of information. Those ever familiar
papers or reports about states, plants, animals,
historical events, literature, science and geogra-

phy are easier now that local, state, and federal
agencies have reliable and updated materials on-
line. Although it is important to avoid personal
web pages for this kind of information, the sites
that are edited by organizations your family
trusts can provide information tailored to your
child’s educational needs. (After all, many of the
contributors to these pages have children doing
the same kinds of papers and reports). The
Internet also provides access to fully accredited
programs for those seeking bachelor’s, masters,
and even doctoral degrees. Remember, be sure
that the information is thoroughly documented
(i.e. footnotes, endnotes, collateral articles, etc.).

Hobbies, Sports, Other
Every craft from quilting and gardening to model
trains and fly-fishing is represented by local and

national organizations who have sites you can
visit on the web. Updates (including video-
replays) are available for most teams and sports.
Professional associations sponsor countless sites
that will help with gardening, remodeling proj-
ects, camping trips, coaching youth sports and
finding accurate resources to make your project
successul.

Finally, the Internet even provides sites that
can help parents evaluate the music, movies, TV
programs, books, games, and Internet sites their
children hear about in their neighborhoods,
churches and schools.

Certainly, like every area of society, the
Internet has a “dark side,” but learning how to
avoid those sites can help you and your family
find the true benefits of a technological “force”
that is changing the speed at which we discover.




Breaking the Bank

The Internet and money compulsions

Everyone loves to get a great bargain-to pay
a lot less for something than it’s worth or to sell
something for more than it cost. But the hunt
for the great bargain or easy dollars can become
an obsession.

Millions of Americans already struggle with
compulsive gambling habits or even compulsive
shopping disorders where their preoccupations
directly interfere with their relationships, mental
health, and financial well-being. The conven-
ience and hyper speed of the Internet seems to
accelerate this problem in two ways: first by
ratcheting up pre-existing compulsions and sec-
ondly by lowering barriers that had kept others
from developing compulsions before.

Dr. Kimberly Young combines compulsive
online auctioning, gambling and trading into a
unique category of online addictions she labels
“net compulsions.” She explains that in each of
these areas, users are motivated by feelings of
power and self-esteem (AddictionSolutions.com
website)

Auctions

eBay, the world’s most popular virtual auc-
tion site, is a yard sale, flea market, and antique
store rolled into one and then multiplied by a
thousand. Today, eBay competes alongside of
hundreds of other online auction sites.

The lure of bargains and sales opportuni-
ties that attract millions of users to online auc-
tion sites. . .including a small percentage who
just can’t get enough.

Erik Hedegaard was one of those people.
He was able to sell a typewriter for the absurd
price of $232.56. He was hooked. Eventually,
Erik devoted more time and energy to online
auctions than he did to his real job. It was start-
ing to drive his wife and daughter crazy.

Conducting business in this way is not
wrong,. It could be a problem if some of the fol-
lowing statements could be said of you: Are you
motivated to spend inordinate amounts of time
at an auction site? Do you constantly check your
email for updates on bids or obsess about buyer
feedback comments? Do you find yourself
browsing and bidding on auction items because
you just enjoy your time on the auction site?
When you recognize a problem, this is the time
to begin to moderate your use of auction sites.

Day trading

People seem to like opportunities to make
a lot of money off a minimal investment. The
Internet not only helped to create much of the
new wealth, it became the place people wanted
to go to make their investments and manage
their wealth. Being your own boss, however, can

have a downside.

That anxiety is the occupational hazard for
anew kind of investor-the day trader. According
to investing columnist Humberto Cruz, day trad-
ing is “the practice of buying and selling a stock
in the same day-or quite often in a matter of
hours if not minutes-to profit form the tiniest
movement in the stock’s price.” Day traders
often work independently, without managers
and supervisors. Cruz is disappointed that so
may voices in today’s financial culture place the
emphasis on “trading” instead of “investing,”

Arnie Wexler is a recovering gambler who
travels the country and wants to talk about all
the people he had met with day trading prob-
lems. Like the 39 year old who retired from busi-
ness and then got into online trading because of
something he heard in a chat room. He started
with $475,000 and lost all but $25,000 of it.

Or the friend who took out an equity loan
for $100,000 and started playing the stock mar-
ket. He paid the loan for up to 6 months so that
his wife wouldn’t get any notices in the mail. He
started trading online at night and from his job.
He finally had to confess when he blew all the
money.

The chances of making a lot of money day
trading just aren’t that good. The financial
Services Authority emphasizes that only 11 per-
cent of all day traders make money, while 70
percent of them lose big, often real big.
Addicts of all stripes typically deny they have a
problem but day traders can have greater
denial because what they are doing is associat-
ed with a legitimate business.

Arthur Levitt, chairman of the Securities
and Exchange Commission appeared before
Senator Collin’s Senate committee. “T am con-
cerned,” he said, “that some day traders don’t
fully understand the risk they are assuming.”
Levitt went on to stress the need for online bro-
kerage services to fully disclose risks up front to
customers.




Gambling

Twenty years ago, legalized gambling oper-
ated in only 2 states, Nevada and New Jersey.
Today it operates in some form in all but 2 states.

A recent federal commission on gambling
estimated that 125 million American adults now
gamble in one form or another. That's over half
of our adult population. No wonder Americans
spend more money on gambling than they do
on movies, spectator sports, concerts, CDs,
theme parks, video games, and even cruise ships
combined. (Christiansen/Cummings Associates,
Inc., An Overview of Gambling in the United
States by Eugene Martin Christiansen)

The Internet now closes any remaining
availability gap-conveniently delivering gambling
to everyone. Arnie Wexler struggled with old-
fashioned casinos. “Now, we've allowed the
Internet to put casinos in offices, college dorms,
and homes,” he says. “Anyone can play any-
where, at anytime.” One lady wrote Arnie to
describe the mess she was able to get into from
home. “T got hooked in by an innocent email
message which contained a hypertext link to an
online casino,” she said. “After three days, hardly
any sleep, and my credit card right next to my
computer, I had lost $6,000.”

Internet casinos handled $2.2 billion in 2000
according to Christiansen Capital Advisors. Four
million Americans are currently gambling online,
according to Cyber Dialogue (Grok, 152). While
some casinos make an effort to watch for com-
pulsive gamblers and try to keep them from get-
ting out of control, the Internet doesn’t have that
level of accountability. “A compulsive user can
rack up thousands of dollars in debt without any-
one knowing,” explains Dr. Valerie Lorenz,
Executive Director of the Compulsive Gambling
Center in Baltimore. “There’s no one around
who can regulate the gambler or put a stop to it.

In fact, the user may not even be an adult.

”

“Because no one stands at the door to the virtual
casino checking IDs, our children have the
means to gamble on the computer after school,”
explains Jeff Houck. (Jeff Houck, “Logging in to a
Cyber Abyss,” January 26, 1999, the Palm Beach
Post, Sport 1C)

Not surprisingly, online gambling is explod-
ing on college campuses. College students have
free time and free Internet access and often have
multiple credit cards-making them a perfect mar-
ket for online gambling. “Internet gambling is as
dangerous as alcohol on campuses,” says Andy
Lissak, “Colleges just don't realize how bad it is.”
Andy saw an ad for an Internet gambling service
in his West Virginia University school paper. He
started going online to place sports bets as often
as three times a day. He lost his girlfriend and
racked up $7,000 in credit card debt.

Alady called Arnie Wexler last year. She told
him that her son was in the early years of college.
He had never gambled before, but he started
betting online. In a short time, he lost over
$30,000 from a checking account and a credit
card. “Tt is easier for a kid on a college campus to
place a bet than it is to buy a can of beer or a
pack of cigarettes,” says Wexler.

The convenience and excitement of gam-
bling sites, day trading services, and even auction
sites can bring out the worst in someone who
has a compulsive money problem. Perhaps
you're struggling with one of these issues. For
the stability of your finances, relationships, and
peace of mind, you need to take steps to break
compulsive net behavior today.

This section is drawn with permission from
Real Solutions for Overcoming Internet

Addiction, by Steve Watters (Published by:
Servant Publications)

Be On Guard
Are you concerned about someone you
know who might have an addiction problem?
Here are some things to watch for:
Someone who has withdrawn or seems to
have escaped in a dream world, is unwilling
to talk about responsibility.
Is prone to emotional outbursts or anxious-
ness.
Is preoccupied with getting ahead without
work or effort.
Has a perceived need for recognition.
Starts to show up with fancy clothes, trips
and cash. They could begin to talk about
gifts for a lot of people.
Has a lot of debt problems.
Is gone for long periods of time without rea-
son at unusual parts of the day.
Wants to spend time on the Internet while
everyone else is away or gone.

Steps You Can Take
Sit down and explain your concerns to your
family member (or close friend) and ask for
some feedback.
Show them unexplained billings while assur-
ing them you only want to help.
Encourage them to find some help with a
local gambling counseling service, pastor or
trusted friends.
Take steps to physically cut off the venue
for gambling as well as access to the supply
of money.

Resources for Net Money Compulsions

Web sites

Center for Online Addiction on Gambling (http://www.netaddiction.com/net_compulsions.htm)
Center for Online Addiction on Daytrading (http://www.netaddiction.com/daytrading htm)
Arnie & Sheila Wexler Associates—resource on compulsive gambling (www.aswexler.com)
Compulsive Gambling Center/ Dr. Valerie C. Lorenz (www.lostbet.com)

Special feature on gambling by Focus on the Family (www.family.org/gambling)

Books

House of Cards: Hope for Gamblers and Their Families by Tom Rabbe (Focus on the

Family/Tyndale, 2001)

Gambling Addiction: The Problem, the Pain, and the Pathway to Recovery by John M. Eades (1999)




The Electronic Trojan Horse

Once in a while we all hear about some-
one’s experience with an overly friendly neigh-
bor. First it’s easy to visit on a regular basis.
Soon they're borrowing all the tools, leaving
messages that aren’t always welcome and
chronically inviting themselves in. Before long
you have a growing nightmare that is ruining
the environment you're trying to protect at
home.

For some families this may be happening
right underneath their noses. However, the
neighbor isn’t next door with a picket fence but
an international computer network that’s
dialed right into your home computer.

Most of us are familiar with the downfall of
Napster, the software program that used to
facilitate music downloads without regard for
industry royalties. Napster promised an online
catalog of music titles collected from its peer
network of computers. U.S. courts put a halt to
the practice based in our country. The Internet,
however, makes everything possible interna-
tionally. Several companies (i.e. KaZaA,
AudioGalaxy, IMesh, LimeWire, Qtraxmax
Morpheus, Grokster, etc.) have stepped in to
facilitate this arrangement from foreign soil.
This creates an electronic by-pass around our
laws that protect artists’ rights for their work.

But the legality of this activity is only the first
issue.

These programs are designed to create an
international peer-to-peer network of comput-
ers without a central catalog anywhere. In other
words, there isn’t 2 main computer server that
facilitates the exchange of songs (a.k.a.
Napster). This model allows a user to download
the program right onto their hard drive.
Currently over 1.5 million computers world
wide have this capacity. Each one is now its
own server in a peer-to-peer network. Every
computer has access to the others on a “first
contact” basis. The software will do a word
search by tapping right into each hard drive.

This creates an incredible internet volume
issue for ISP providers. Some companies have
experienced overload problems trying to deal
with the shear volume of activity that occurs
when the kids get out of school. Even at an
institutional level (i.e. high schools, colleges,
business, etc.) in-house network servers are
shutting down since they are unable to deal
with the volume of requests. Internet providers
can block the site but these software programs
are designed to automatically search among the
65,000 ports available until it can get through
anyway. ISP providers are left with an expensive

equipment purchase to become capable of
stopping all the software designed efforts. You
should check with your provider to see what
their capacity is for stopping this activity.

Why should you be concerned about this?
It represents the status of an “unwelcome
neighbor” in three significant ways.

First, the most prominent words searched
for by these programs aren’t music relat-
ed. They are pornographic and obscenity
based (i.e. Adult, XXX, porn, sex).
Thousands of youth are downloading this
software in the afternoon, downloading
music that night and learning in a few days
they can search for a lot more. After taking
all kinds of measures to filter your
machine, the thorough search of these
programs may be getting past your ISP’s
best efforts. It is quickly becoming one of
the main sources of Internet pornographic
activity.

Secondly, these programs use a type of
“Spyware” to monitor user activity.

Eventually they can capture your e-mail
activity and address book to sell to mar-
keting companies. Before long you can




find yourself with more spam than you
can imagine. Since it’s from a foreign
source it is impossible to deal with legally.

Finally, this network frequently facilitates
the activity of “zombie” virus software. It
will lay dormant on your computer until
another source requests it to come alive.
When activated, it can have several effects.
A source can actually use this virus to shut
down access to an ISP so that all users are
prevented from getting in, called a denial
of service attack (or DoS). It can create so
many activity requests that the ISP
provider simply cannot support it. Even
more invasive is how this same type of
virus software can be used to capture
thousands of processors in the network to

solve an equation. In other words, a prob-
lem solver needs more computer power
and memory than his platform provides.
By capturing all these other computers,
the problem is divided among them all
while they work together to solve it. In the
meantime, a user can approach his com-
puter only to find it slow and somewhat
unresponsive. It appears normal on the
surface, but it’s very busy behind the
scenes crunching numbers and consum-
ing internet bandwidth. When the prob-
lem is solved it wakes up and functions
normally after its time in “hijack” mode.

If you are concerned that any of these file
sharing programs have been downloaded to
your computer, it is possible to remove them

and prevent future intrusion. Unfortunately,
due to their nature, KaZaA and other similar
programs cannot be completely removed using
the Windows remove programs option. It is
necessary to either use a program removal tool
or to contact your local computer technician
who can ensure all traces of the programs are
removed and that your unwelcome house
guest is finally evicted.

Just like the growing problems of an over
friendly neighbor these programs aren’t what
they seem to be on the surface. Be sure your
computer hasn’t downloaded one of these pro-
grams and that your ISP provider offers you
genuine protection.




Resource List

ORGANIZATIONS

This section lists just a few of the many organiza-
tions that are actively fighting the Dark Side of
the Internet.

National Coalition for the
Protection of Children and Families
800 Compton Road, Suite 9224

Cincinnati, OH 45231

5135216227

www.nationalcoalition.org

Enough is Enough
746 Walker Road, Suite 116
Great Falls, VA 22066
www.enough.org
www.protectkids.com

Focus on the Family
8605 Explorer Drive
Colorado Springs, CO 80995
7195315181

800-A-FAMILY
www.family.org

National Center for Missing and
Exploited Children

Charles B. Wang International Children’s
Building

(699 Prince Street

Alexandria, VA 22314-3175

703-274-3900 or

1-800-THE-LOST

www.missingkids.com

HELPFUL BOOKS

This is an assortment of print materials designed
to help individuals and families confront and
cope with some Internet related issues.

Pornography Addictions:
Boundaries—Dr. Henry Cloud and Dr. John
Townsend

Living in Victory—Steve Gallagher

At the Alter of Sexual Idolatry—Steve Gallagher
Every Man’s Battle—Stephen Arterburn and Fred
Stoeker

Real Solutions for Overcoming Internet
Solutions—Steve Watters

Women Living With
Disappointment:

Living Through Your Husband’s Secret Wars—
Marsha Means

When His Secret Sin Breaks Your Heart: Letters
to Hurting Wives—Kathy Gallagher

An Affair of the Mind—Taurie Hall

Counseling and Treatment:
Counseling the Sexual Addict—Steve Gallagher
Pure Desires—Ted Roberts

Break Free—Steve Gallagher

About Youth:

Toxic Porn—Gene McConnell (Focus on the
Family)

Reviving Ophelia—Mary Pipher

INFORMATIVE
WEB LINKS

Here are some web locations you can go to for
more information on the subject of Internet
safety. These listings do not automatically imply
endorsement.

www.georgiafamily.org
Informative web site on critical issues facing the

family today with a special emphasis on strength-

ening marriages, cultivating effective fathers and
helping youth remain abstinent until marriage.

www.enough.org/
justharmlessfun.pdf

Presents a compelling case that pornography in
any form is harmful. (This is a PDF document; if
your computer doesn't already have acrobat read-
er installed, you can download it for free from
www.adobe.com/products/acrobat/readstep.html)

www.enough.org/myths1-9.htm
Convincingly dispels the nine key myths that are
typically used in defense of pornography.

www.netaddiction.com

The Center for On-Line Addiction provides addi-
tional advice and resource regarding Internet
Addiction.

www.fflibraries.org

Family Friendly Libraries is a national grassroots
network of concerned citizens, librarians, and
library trustees. They promote common sense
access policies to protect children from expo-
sure to age-inappropriate materials without
parental consent.

www.safetyed.org

SafetyEd International advises parents, teachers,
schools and libraries about online safety issues
for kids when going online.

www.webwisekids.com
Web Wise Kids acts as an internet safety resource
center for parents, teachers and children.

www.moralityinmedia.org
Morality in Media is a national, not-for-profit,
interfaith organization established in 1962 to
combat obscenity and uphold decency stan-
dards in the media.

www.getnetwise.org

Setup to help parents deal with the dangers of
the Internet with information and recommenda-
tions.

www.FilterReview.com

Contains reviews of filtering software and filtered
Internet service providers. Produced by the
National Coalition for the Protection of Children
and Families as a resource to the public.

www.designpointinc.com
Design & advertising firm responsible for design
and production of this publication.




Family-Based Filtered ISPs

If you do not currently receive your Internet service from a family-based group, you may find a provider who meets your specific needs from the follow-

ing list. Note: This list is provided simply as an overview of family-based Internet Service Providers (ISP’s) and does not represent an endorsement.

Service Provider
*American Family Online
Angel Safe Net
CharacterLink

Christian Purity Family Internet
*Christian Living Network
CleanSurf

*CleanWeb

Clear Sail

Covenant Promotions
CyberSafe.net

Devotional Internet Services
Family.net

Family’s Choice

Freedom ISP

Fish Net Online
Hedgebuilders A+ Filtering
Honorguard

Ineva.com
Internet-4-Families
Integrity Online

Mayberry USA

MStar.net

Northern Trail
PKFamily.com

Safe Access

Safe Browse
Squeaky-Clean.net
WiseChoice.net

World Christian Online Inc.
ZOL Online

Web Site
www.afo.net
www.angelsafenet.com
www.characterlink.net
www.christianpurity.com
www.christianliving.net
www.cleansurf.com
www.cleanweb.net
www.clearsail.net
WWW.covenantpromotions.com
www.cybersafe.net
www.dinternet.org
www.family.net
www.familyschoice.com
www.freedomisp.net
www.fnol.net
www.hedgebuilders.com
www.honorguard.net
WWW.ineva.com
www.idf.com
www.integtity.com
www.mbusa.net
Www.mstar2.net
www.northerntrail.net
www.pkfamily.com
www.safeaccess.com
www.safebrowse.com
www.squeaky-clean.net
www.wisechoice.net
www.worldchristian.net

www.zol.com

*These Internet Service Providers contribute a percentage of their income to ministries.

Phone Number

(888) 8179314
(866) 540-1027
(838) 330-8678
(800) 7917011
(888) 772-7355
(918) 747-0009
(800) 514-4602
(888) 9050888
(888) 564-7555
(970) 484-1933
(877) 944-7070
(888) 905-0888
(866) 2347233
(866) 841-2544
(800) 286-2074
(615) 952-4200
(800) 508-1251
(866) 8389329
(888) 654-8288
(866) 449-1736
(888) 711-6381
(877) 365-5465
(248) 2172029
(888) 711-6381
(888) 7347233
(877) 944-7070
(877) 885-5560
(478) 7389927
(615) 5687112
(866) 683-6837

Cost
$21.95
$21.95
$10 to $30
$15.95
$19.95
$4.95
$21.95
$21.95
$18.95
$21.95
$21.95
$21.95
$15.95
$22.95
$21.95
$36.00 (6 months)
$17.95
$19.95
$21.95
$21.95
$21.95
$19.95
$17.95
$17.95
$17.95
$19.95
$19.95
$30.00 (6 months)
$17.95
$19.95




Georgia Family Council:

An Organizational Overview

Georgia family Council (GFC) is a non-profit research and education
organization that analyzes how cultural trends and public policies
affect family life. GFC was established in response to the mounting evi-
dence that family breakdown is at the root of the deterioration of
social order and child well-being in our country and state.

GFC seeks to make an impact in three areas:

1. Informing the public: We endeavor to inform the public about fami-
ly issues by providing accurate and timely information to those in the
media.

2. Helping our communities: Our goal is to foster community-based
solutions that strengthen families and connect people to resources
that strengthen family relationships.

3. Assisting policy makers: We help policy makers and citizens under-
stand laws in light of whether or not they help or harm the family.

GFC labors for changes that will restore strength and

stability to Georgia’s families and communities. For more information, go
to our website at www.georgiafamily.org or call 1-800-FAMILY-1.
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